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[bookmark: _Toc342482704]Tips for Taking an Online Course 
Benefits to Online Learning
· You have control over the learning environment.
· You have control over the day and time of day you take the class.
· You have control over how long you participate at one sitting.
· You (may) have control over with whom you participate.   
Disadvantages to Online Learning
· You can’t interact with the instructors in real time (but you can contact them, see their contact information in this Guide).
Learning Environment 
· If you’re taking this course with a group of people, then you’re probably in a conference room.
· If you’re taking this course alone, then you’re probably at your desk or in a library or at home. 
· Let others know you are taking a class and are not to be disturbed.  
· Turn off your cell phone and other distractions.  
· Put up a Do Not Disturb sign (although this would be a little odd if you’re in a library or coffee shop).  
· Get comfortable.  
· Make sure you can see the screen and hear the audio.
· Use headphones if you’re in a place where you don’t want to disturb others.  
· Keep side conversations to a minimum if you’re watching with a group of people.  You may not be interested, but the person next to you might be, so shhhhhhh.
· Pick a day and a time of day when you are fresh and alert.    
· If you miss something, stop the video and watch it again.  
· If you need to think about something, stop the video and think about it.  
· If you need to talk about what you heard with someone, stop the video and talk about it.
· That’s the beauty of online learning – you have control!  (see Benefits, above)
Course Materials
· Participant Guide  
· Maps of your Planning Area 
· Final Environmental Impact Statement/Proposed Resource Management Plan and Record of Decision
· Copies of activity-level plans and decisions, and any documents carried forward into your ROD
· 2005 BLM Planning Handbook (H-1601-1).  Click the hyperlink or search the Web for “BLM Planning Handbook” or go to the webpage where you launched this course.  
· Current Planning Target Allocation (PTA) for your Field/District office 
· Current and past year’s Annual Work Plan (AWP) for your Field/District office 
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Course Outline and Objectives 
The purpose of these three modules is to show you how to develop a strategy to implement your land use plan.  The goal of plan implementation strategy is to increase the consistency of plan implementation among BLM offices, track and measure the progress of implementation by connecting workload accomplishments to land use plan decisions, provide stable and attainable targets, and provide BLM field offices, district offices, and state offices with a valuable tool to prioritize and plan its workload.   

Module 1 Outline.   Step 1:  Outline the Work
Introduction
Overview of the 3-Step Implementation Strategy Process
Overview of the Worksheet
How to do Step 1
Examples
	Taos (NM) RMP
	Casper (WY) RMP
	Agua Fria NM and Bradshaw-Harquahala (AZ) RMPs 
Conclusion/Next Steps


Module 1 Objectives.   Step 1:  Outline the Work
List the projects/tasks/management actions needed to implement your RMP over the next 3 to 5 years.
Identify Project Element (PE) Codes for each project/task/action.
Identify geographic location for each project/task/action.
Populate columns 3, 4, 5, and 13 in the Plan Implementation Strategy Worksheet.
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Megan Stouffer
Branch Chief for Planning and Assessment 
BLM Colorado State Office
mstouffe@blm.gov
303-239-3936

Brad Higdon
Taos RMP Team Lead
BLM Taos Field Office (Farmington District)
bhigdon@blm.gov 
575-751-4725
[bookmark: _GoBack]
Joe Meyer
Field Manager
Casper Field Office (High Plains District)
jmeyer@blm.gov 
307-261-7776
Rem Hawes
Field Manager 
Hassayampa Field Office (Phoenix District)
rhawes@blm.gov 
623-580-5530

Cathy Humphrey (Host)
Planning/NEPA Training Coordinator
National Training Center
chumphre@blm.gov
602-906-5536
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UNITED STATES DEPARTMENT OF THE INTERIOR
BUREAU OF LAND MANAGEMENT
WASHINGTON, D.C. 20240 
http://www.blm.gov 
October 25, 2012 
In Reply Refer To: 
1610 (210) P 
EMS TRANSMISSION 11/20/2012 
Instruction Memorandum No. 2013-014 
Expires: 09/30/2014 
To:	All Field Office Officials
From:	Director
Subject:	Revised Guidance for Establishing Implementation Priorities for Land Use Plans
Program Area: 	All Program Areas 
Purpose: This Instruction Memorandum (IM) replaces IM 2008-041, Guidance for Establishing Implementation Priorities for Land Use Plans (LUPs). This guidance was developed through a collaborative process and was informed by lessons learned from previous implementation workshops and through a national survey on the effectiveness of the workshops. The IM is designed to meet the Bureau of Land Management’s (BLM’s) obligation to better implement, monitor, and evaluate land use plans. 
The process laid out in this IM seeks to improve LUP implementation by simplifying and reformatting the LUP Implementation Strategy. The goals of the process are to increase consistency in LUP implementation; track and measure the progress of implementing plans by connecting workload accomplishments to LUPs; provide stable and attainable targets; and provide BLM Field Offices (FOs), District Offices (DOs) and State Offices (SOs) a valuable tool for prioritization and workload planning. 
Changes from the past implementation processes include: 
· Three online video modules available through the National Training Center (NTC) replace Washington Office (WO) in-person facilitation; 
· Increased facilitation and review role for SO Planning & Environmental Coordinators (P&ECs); 
· Modification from a four-step to a three-step process; 
· Elimination of mandatory budget formulation and development; 
· Development of a LUP communication strategy separate from the LUP implementation process; and 
· Simplification of the LUP implementation worksheet. 
Policy/Action: The FO must complete the three-step implementation process described below within 1 year after the signing of the Record of Decision. Field Office staff will form interdisciplinary teams for plans completed after 2008 that have not undergone an implementation strategy must also complete this process. Such teams may also be formed to complete the process for older plans. The process gives program specialists, managers, and others involved in the LUP process an opportunity to identify, prioritize, and budget for the work outlined in the LUP. 
After completing a LUP, the interdisciplinary team, with managerial involvement, should view Module 1 (Step 1) of the online implementation training, available through the Department of the Interior (DOI) Learn and the NTC’s Knowledge Resource Center (KRC) at http://www.ntc.blm.gov/krc/viewresource.php?courseID=590. 
Step 1 of the implementation training involves identifying the work associated with implementing the LUP, the geographic location of work in the planning area, and the accompanying Program Elements (PEs) that measure that work. To complete Step 1, the interdisciplinary team will populate the relevant columns of the plan implementation worksheet (in Excel). Although not required, it may be beneficial to include the SO Planning and Environmental Coordinator (P&EC) in Step 1. 
After populating the columns of the plan implementation worksheet that correspond with Step 1, the field manager will send the completed worksheet to their SO P&EC, who will review it for adequacy and completeness, and then grant the FO the permission to proceed with Step 2. 
Step 2 involves documenting the priority of the work identified in Step 1 in the relevant columns of the plan implementation worksheet. Similar to Step 1, the interdisciplinary team should view Module 2 of the online plan implementation training on DOI Learn or the KRC and, with help from a facilitator, complete Step 2 of the plan implementation strategy. The SO P&EC should facilitate the training; if the SO P&EC is unavailable, they will contact the NTC, who will help identify a facilitator. 
Step 3 involves scheduling the work into the out-years in the relevant columns of the plan implementation worksheet. Instructions on how to do this are in Module 3 of the online plan implementation training. This work can be scheduled immediately following Step 2, or at a later time. Step 3 should also be completed with help from the SO P&EC or another trained facilitator. 
Involving the field manager in Steps 2 and 3 is critical. Additionally, involving the district manager, cooperating agencies, state program leads, budget officers, or other internal and/or external partners to participate in Steps 2 and 3 can greatly enhance the value and effectiveness of the implementation strategy. The FOs should ensure that the implementation strategy worksheet is a living document that is updated annually to include new fiscal years and changing priorities. 
The benefits of a completed implementation strategy worksheet are numerous: it will help with both internal and external priority setting and workload planning, and it can also assist the FO as it develops a budget framework and requests funding for the various tasks identified in the LUP. 
All documents associated with the revised LUP Implementation Strategy process (including the Participant Guide, example Excel spreadsheet, and blank plan Implementation Strategy template), and links to all three training modules can be found on the NTC’s KRC at:  http://www.ntc.blm.gov/krc/viewresource.php?courseID=590. 
Timeframe: This IM is effective immediately. 
Budget Impact: The overall impact to budgets will be minimal. Implementation of this guidance should improve identification and reporting of priority actions to implement and evaluate LUPs. 
Background: The BLM has strived to improve FOs ability to implement, monitor, and evaluate LUPs for some time. The initial development of a LUP implementation framework and strategy began in the early 2000s. Performance evaluations showed that the BLM did not have a systematic program in place to monitor and evaluate LUP effectiveness based on budget and performance. As a result, the BLM developed an interdisciplinary process for LUP implementation and evaluation. The intent of the program was to provide the BLM with a systematic method for planning and achieving the desired outcomes for LUPs based on anticipated funding. As of the date of this IM, FO’s have conducted 49 LUP implementation workshops. 
Manual/Handbook Sections Affected: This policy replaces IM 2008-041, Guidance for Establishing Implementation Priorities for Land Use Plans (12/10/07), and the “collaborative four-step method for developing an implementation strategy…” found in Section IV, E “Developing Strategies to Facilitate Implementation of LUPs” in the BLM Land Use Planning Handbook, H-1601-1 (03/11/05). 
Coordination: The process identified in this policy was developed with the assistance of multiple BLM FOs and SOs, the NTC, FA-600, WO-210, and WO-170. 
Contact: For further information, contact Thomas Bartholomew, Program Analyst at 202-912-7201, Dave Johnson, Planning and Environmental Analyst at 202-912-7292, or Cathy Humphrey, NTC Training Coordinator at 602-906-5536. 


Signed by:	Authenticated by:
Mike Pool	Robert M. Williams
Acting, Director	Division of IRM Governance, WO-560








Last updated: 11-20-2012 USA.GOV | No Fear Act | DOI | Disclaimer | About BLM | Notices | Social Media Policy Privacy Policy |  


[bookmark: _Toc342482708]Sample Excel Spreadsheet 
Example for Direct Community Services – Columns 1-5
	1 & 2

Resources and Programs
(Talk to your state P&EC to make any changes)
	3

Projects, Management Actions, Tasks  
(from RMP)
	4

PEs 
	5


Where

	Fire Management
	Wildfire Management
	 
	 
	 

	
	
	 
	 
	  

	
	
	
	
	

	Access
	Land Tenure
	
	
	

	
	
	
	
	

	
	Land Use (ROWs)
	 
	
	 

	
	
	 
	
	 

	
	
	
	
	

	
	Unauthorized Use
	 
	
	 

	
	
	 
	
	 



Example of Columns 6-13:
	6


Priority
	7


Magnitude
	8


FY12
	9


FY13
	10


FY14
	11


FY15
	12


FY16
	13

Cross Reference

	
	
	
	
	
	
	
	

	 
	 
	 
	 
	 
	 
	 
	 

	 
	 
	 
	 
	 
	 
	 
	 

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	



	Blue represents cells that will be filled in for you.

	 Yellow represents cells you will fill out in STEP 1.

	Red represents cells you will fill out in STEP 2.

	Purple represents cells you will fill out in STEP 3.



NOTE:  To see a completed example spreadsheet, click here.  This example was developed based on real BLM projects across several planning areas to provide you with some ideas to complete your own spreadsheet. 

[bookmark: _Toc342482709]Resource Categories Outline 
	Resource Categories 
	Resources and Programs

	Natural Resources
	Physical Resources
	Air

	
	
	Water

	
	
	Soil

	
	
	Geological

	
	Biological
	Forests and Woodland Health

	
	
	Grasslands and Shrublands

	
	
	Riparian/ Wetlands

	
	
	Invasive/Non-native species

	
	
	Fish and Wildlife

	
	
	Special Status Species

	Heritage Resources
	Cultural/Paleo
	Cultural  

	
	
	Paleontological

	
	Special Designations
	ACEC 1

	
	
	ACEC 2

	
	
	Wild and Scenic Rivers

	
	
	Wilderness and WSAs

	
	
	Wild Horse and Burros

	
	
	Other

	Energy and Minerals
	Non-Renewable Energy
	Oil and Gas

	
	
	Coal

	
	
	Oil Shale and Tar Sands

	
	Renewable Energy
	Geothermal

	
	
	Solar

	
	
	Wind

	
	Minerals
	Locatable

	
	
	Salable

	
	
	Non-Energy Leasable

	Forest Products and Livestock Management
	Livestock Management
	Enhancing Range Management

	
	Forest Products
	Commercial Sales

	
	
	Non-Commercial Sales, Activities

	Recreation and Travel Management
	Recreation
	SRMA 1

	
	
	SRMA 2

	
	
	ERMAs

	
	
	Dispersed Recreation

	
			Travel
	Management

	
	
	Facilities

	Direct Community Services
	Access
	Land Tenure

	
	
	Land Use/ROWs

	
	
	Unauthorized Use

	
	Fire Management
	Wildfire Management

	
	Public Safety
	Law Enforcement

	
	
	Hazardous Waste

	
	
	Abandoned Mine Lands


[bookmark: _Toc342482710]Types of Work to Accomplish Outcomes Checklist 
Instructions:  This checklist can be used to help the team brainstorm, and to ensure you identify all the work that is done in the planning area.  That includes projects, tasks, and management actions from the land use plan, as well as the non-discretionary work that may not be explicitly listed in the plan. 

Suggested Participants:  Interdisciplinary team (small groups), field and/or district manager.  
(NOTE:  although you can involve partners in Step 1, they may be more effective/valuable in Steps 2 and 3.  A facilitator can be helpful, but is less critical than for Steps 2 and 3.)

 Provide Outreach
This would include projects such as brochure development, signage and development of maps.  Project codes such as AL (Public Outreach Through Interpretation & Environmental Education) or AJ (Native American Consultations) would be included in this category.
 
 Assess/Inventory Condition/Status
This includes surveys of habitat, land health and maybe public visitation surveys.  This could also include cultural and wildlife surveys for implementation projects. Project codes such as BO, inventory of soil resources or CC, assessment of air resources conditions would be examples of this category.

 Perform Planning
This includes any form of planning such as travel management plans (DA), ACEC activity plans (DF) or maybe habitat management plans (DK). 

 Authorize Use
This would include a lot of third party actions in which a party comes in with an application.  Examples include permit renewals (EE), ROW authorizations (ER), leasing and development of oil and gas (EI- leading).

 Implement BLM-initiated Actions
These projects might include restoration activities, habitat improvement projects, or prescribed fires.  These are the things the BLM does to meet goals and objectives without impetus from the public or a third party.  This could include maintenance of recreation sites (IA) or trails (ID), constructing vegetation treatments (JA) or processing land sales (KD).

 Perform Monitoring
As opposed to assessment and inventories, monitoring refers to determining the effectiveness of project implementation and whether or not the BLM is meeting its objectives.  This might include projects such as monitoring the effectiveness of a vegetation treatment or prescribed burn (MB), monitoring grazing allotments (ML) or conducting Fluid Mineral Surface and Environmental Monitoring (MW).

 Manage Compliance
This refers to the inspections and monitoring of implementation activities such as drilling inspections (NB) and review of existing ROWs (NH).  This could also include law enforcement activities.  Basically, this strategy category refers to the activities BLM takes to make sure third parties are following the rules.
Note that with oil and gas, performing monitoring refers to studying surface conditions while managing compliance refers to inspection and enforcement of COAs and production values.
											
 Manage Work/Partnership & Community Relations
This includes the work involved in developing partnerships, cooperating on projects and building relationships in the community. This could include sharing data and/or cooperating on fire management plans.
 
There are no measurable codes for this category at present.  Each code refers to providing program support and can include activities such as cooperation and other unmeasured workloads.
					



[bookmark: _Toc342482711]Program Element (PE) Codes for FY12 
Instructions:  Determining the appropriate Project Element (PE) code(s) for each project, task, or management activity should be fairly straight-forward.  The following list is for FY12, be sure to check the list for the current fiscal year, as codes change periodically.  Identifying the proper PE code for each project or task identified is done in Step 1; determining how many units per year will be completed is part of Step 3.  Remember, there may be more than 1 PE code for a single project/task/management action.  
Suggested Participants for Step 1:  Facilitator, interdisciplinary team (small groups), field and/or district manager; (partners and cooperating agencies are optional).

	Bureau of Land Management
Alignment of Program Elements to Performance Measures for FY 2012

	M1
	Provide Natural and Cultural Resource Protection and Experiences

	M1.G1
	Protect America's Landscapes

	M1.G1.S1
	Improve land and water health

	M1.G1.S1.01
	Percent of DOI stream/shoreline miles that have achieved desired condition where condition is known and as specified in management plans. (SP)
	100%
	BV
	INVENTORY STREAMS/RIPARIAN AREAS
	Miles inventoried

	
	
	100%
	MO
	MONITOR STREAM/RIPARIAN HABITAT
	Miles monitored

	M1.G1.S1.02
	Percent of DOI acres that have achieved desired condition where condition is known and as specified in management plans. (SP)
	100%
	BO
	INVENTORY SOIL RESOURCES
	Acres Mapped

	
	
	100%
	BP
	ASSESS WATERSHEDS
	Acres Assessed

	
	
	100%
	BQ
	INVENTORY OF ECOLOGICAL SITES
	Acres of completed inventory

	
	
	100%
	BR
	INVENTORY SHRUB/GRASS/PJ VEGETATION
	Acres Inventoried

	
	
	100%
	BT
	INVENTORY FOREST/WOODLAND VEGETATION
	Acres inventoried

	
	
	100%
	BU
	INVENTORY LAKES/WETLAND AREAS
	Acres inventoried

	
	
	100%
	CC
	ASSESSMENT OR PREDICTION OF AIR RESOURCE CONDITIONS
	Number of actions completed

	
	
	100%
	CD
	ASSESS ECOREGIONS
	Assessments Completed

	
	
	100%
	DX
	COMPLETE RMP IMPLEMENTATION STRATEGIES
	Number completed

	
	
	100%
	EC
	PROCESS WATER RIGHTS ACTIONS
	Actions processed

	
	
	100%
	MB
	EVALUATE FOREST/WOODLAND TREATMENTS
	Acres evaluated

	
	
	100%
	MI
	MONITOR AIR QUALITY AND CLIMATIC CONDITIONS
	Number of parameters collected

	
	
	100%
	MJ
	EVALUATE LAND HEALTH
	Land Health Evaluation Reports completed

	
	
	100%
	ML
	MONITOR GRAZING ALLOTMENTS
	Allotments monitored

	
	
	100%
	MN
	MONITOR LAKE/WETLAND HABITAT
	Acres monitored

	
	
	100%
	MX
	MONITOR SHRUB/GRASS VEGETATION TREATMENTS
	Acres monitored

	M1.G1.S1.03
	Percent of baseline acres infested with invasive plant species that are controlled. (SP)
	100%
	BS
	INVENTORY FOR PRESENCE OF INVASIVE AND/OR NOXIOUS WEEDS
	Acres inventoried

	
	
	100%
	MK
	EVALUATE WEED TREATMENTS
	Acres Evaluated

	M1.G1.S1.04
	Percent of invasive animal species populations that are controlled. (SP)
	100%
	CF
	INVENTORY INVASIVE ANIMAL POPULATIONS
	Populations

	M1.G1.S1.05
	Number of DOI riparian (stream/shoreline) miles restored to the condition specified in management plans. (SP)
	100%
	JG
	APPLY STREAM/RIPARIAN TREATMENTS
	Miles treated

	M1.G1.S1.06
	Number of DOI (upland + wetland) acres restored to the condition specified in management plans. (SP)
	100%
	DF
	PLAN FOR INTERDISCIPLINARY ACTIVITIES
	Number of new or revised interdisciplinary activity plans completed

	
	
	100%
	JA
	APPLY SHRUB/GRASS VEGETATION TREATMENTS
	Acres Treated

	
	
	100%
	JB
	CONSTRUCT SHRUB/GRASS/PJ/FOREST PROJECTS
	Projects completed

	
	
	100%
	JC
	MAINTAIN SHRUB/GRASS/PJ/FOREST PROJECTS
	Projects maintained

	
	
	100%
	JD
	APPLY WEED TREATMENTS
	Acres treated

	
	
	100%
	JE
	RESTORE FOREST AND WOODLANDS THROUGH SALES
	Acres restored – equal to acres yarded reported in the TSIS or SCID

	
	
	100%
	JF
	APPLY LAKE/WETLAND TREATMENTS
	Acres treated

	
	
	100%
	JH
	CONSTRUCT LAKE/WETLAND/STREAM/RIPARIAN PROJECTS
	Projects completed

	
	
	100%
	JI
	MAINTAIN LAKE/WETLAND/STREAM/RIPARIAN PROJECTS
	Projects completed

	
	
	100%
	JN
	RESTORE FOREST AND WOODLANDS THROUGH DEVELOPMENT
	Acres restored through forest development

	
	
	100%
	JX
	DECOMMISSION AND REHABILITATE ROADS AND TRAILS
	Miles

	
	
	100%
	JZ
	NATIVE PLANT MATERIALS COLLECTION
	collections completed

	M1.G1.S1.07
	Percent of surface waters (acres) managed by DOI that meet State EPA Approved Water Quality Standards. (Bureau Measure)
	100%
	MU
	MONITOR WATER RESOURCES
	Number of Parameters Collected

	M1.G1.S1.08
	Percent of surface waters (stream miles) managed by DOI that meet State (EPA Approved) Water Quality Standards. (Bureau Measure)
	100%
	BN
	INVENTORY WATER RESOURCES
	Number of Parameters Collected

	M1.G1.S1.09
	Wild Horse and Burro Management Areas: Cumulative of number of Herd Management Areas (HMAs) achieving appropriate management levels. (Bureau Measure)
	100%
	DI
	PLAN FOR HERD MANAGEMENT
	Number of Herd Management Areas (HMA) where Appropriate Management Levels (AML) is established or adjusted

	
	
	100%
	HG
	ADOPT WH&B
	Animals adopted

	
	
	100%
	HH
	LONG-TERM HOLD WH&B
	Number of animal feeddays for all animals older than 6-months of age held or born in a long-term holding facility

	
	
	100%
	HI
	PREPARE/HOLD WH&B
	Number of animal days for all animals held or born in a short-term holding facility

	
	
	100%
	JJ
	GATHER/REMOVE WILD HORSES AND BURROS
	Animals Gathered

	
	
	100%
	MC
	CONDUCT SURVEY OF WH&B AREAS
	HMAs Surveyed (Censused)

	
	
	100%
	MP
	MONITOR WH&B HERD MANAGEMENT AREAS
	HMAs monitored

	
	
	100%
	NK
	CONDUCT WH&B COMPLIANCE INSPECTIONS
	Number of animals receiving field compliance reviews

	M1.G1.S1.10
	Percent of plans completed within four years of start. (Bur/PART)
	100%
	DB
	PLAN FOR COMMERCIAL ACTIVITIES
	New or revised activity plans

	
	
	100%
	DN
	PREPARE PRE-LAND USE PLAN
	Pre-plans completed

	
	
	100%
	DO
	COMPLETE LAND USE PLAN SCOPING REPORT/PLANNING CRITERIA
	Number Completed

	
	
	100%
	DP
	PREPARE DRAFT LUP
	Number Completed

	
	
	100%
	DQ
	PREPARE PROPOSED LUP/FINAL EIS
	Number Completed

	
	
	100%
	DR
	RESOLVE PROTEST/PREPARE ROD
	Number Completed

	
	
	100%
	DS
	PREPARE DRAFT EIS LEVEL LUP AMENDMENTS
	Number Completed

	
	
	100%
	DT
	PREPARE FINAL LUP AMENDMENT/ROD
	Number Completed

	
	
	100%
	DU
	PREPARE EA LEVEL LUP AMENDMENT/DR
	Number Completed

	
	
	100%
	DV
	REVIEW OTHER BUREAU PROPOSED ACTIONS
	reviews conducted

	M1.G1.S1.11
	Percent of Resource Management Plan evaluations completed within 5 years, (Bur)
	100%
	DJ
	EVALUATE LAND USE PLANS
	Evaluations completed

	M1.G1.S1.12
	Number of Resource Management Plans/EIS completed (Bureau Measure)
	Support Measure - No Cost

	M1.G1.S1.13
	Percent of Resource Management Plans evaluated by the BLM Director as making significant progress toward achieving riparian condition goals. (Bur)
	Support Measure - No Cost

	M1.G1.S1.14
	Percent of public lands where visual resource management data have been recorded in digital format for both inventory and management classes. (Bureau Measure)
	Support Measure - No Cost

	M1.G1.S1.15
	Percent of sites (acres) reclaimed or mitigated from the effects of degradation from past mining. (Bureau Measure)
	100%
	BH
	INVENTORY ABANDONED MINE LAND SITES (AML)
	Sites inventoried

	
	
	100%
	HP
	REMEDIATE AML PHYSICAL SAFETY HAZARDS
	Sites remediated

	
	
	100%
	JK
	IMPLEMENT AML PROJECTS TO RESTORE WATER QUALITY
	Acres of completed remediation

	
	
	100%
	LB
	MONITOR AND MAINTAIN AML PHYSICAL SAFETY CLOSURES
	Sites where monitoring actions are completed

	M1.G1.S1.16
	Land Contamination: Percent of known contaminated sites remediated on DOI managed land. (Bureau measure)
	100%
	BF
	ASSESS HAZMAT SITES
	Site verifications / evaluations / assessments / inspections completed

	
	
	100%
	HO
	RESPOND TO HAZMAT RISK SITES
	Actions completed

	
	
	100%
	MG
	MONITOR AND MAINTAIN AML WATER QUALITY, HAZMAT & NRDAR SITES
	Sites where monitoring actions are completed

	
	
	100%
	NP
	EVALUATE PRPS FOR COST AVOIDANCE/RECOVERY
	Actions completed

	
	
	100%
	NQ
	PROCESS HAZMAT COST AVOIDANCE/RECOVERY CASES
	Cases referred

	M1.G1.S1.17
	Percent of physical and chemical hazards mitigated in appropriate time to ensure visitor or public safety. (Bureau Measure)
	100%
	BG
	ASSESS OTHER HAZARDS (NON HAZMAT OR AML)
	Verifications, assessments, evaluations completed

	
	
	100%
	HQ
	MITIGATE OTHER HAZARDS
	Sites mitigated

	M1.G1.S1.18
	Number of incidents/investigations closed for natural, cultural, and heritage resources offenses
	100%
	NV
	CONDUCT INVESTIGATIVE ACTIVITIES
	Incidents investigated

	M1.G1.S1.19
	Number of natural, cultural, and heritage resource crimes detected that occur on BLM lands
	100%
	NU
	CONDUCT PATROL ENFORCEMENT ACTIVITIES
	Number of Incidents Reported

	
	
	100%
	NY
	CONDUCT EMERGENCY RESPONSE ACTIVITIES
	Incidents responded to

	
	
	100%
	NZ
	CONDUCT SECURITY ACTIVITIES
	Vulnerability Assessments & Physical Security Assessments

	
	
	100%
	OA
	CONDUCT DRUG ENFORCEMENT ACTIVITIES
	Seizure incidents

	M1.G1.S1.20
	Cumulative number of Herd Management Areas (HMAs) treated or where population suppression techniques were conducted. (Bureau)
	100%
	KF
	ANIMALS GATHERED FOR FERTILITY CONTROL
	Animals Gathered

	
	
	100%
	KG
	ANIMALS TREATED TO REDUCE POPULATION
	Animals Treated

	M1.G1.S2
	Sustain species health

	M1.G1.S2.01
	Number of threatened and endangered species recovery implementation activities implemented. (SP)
	100%
	DK
	PLAN FOR T&E SPECIES RECOVERY
	Plans completed

	
	
	100%
	JP
	IMPLEMENT THREATENED AND ENDANGERED SPECIES RECOVERY ACTIONS
	Recovery actions performed

	M1.G1.S2.02
	Percent of populations of species of management concern that are managed to desired condition. (Bureau Measure)
	100%
	CB
	INVENTORY WILDLIFE/PLANT HABITAT
	Acres inventoried

	
	
	100%
	KE
	IMPLEMENT CONSERVATION ACTIONS FOR NON-ESA SPECIES AND COMMUNITIES
	Actions performed

	
	
	100%
	MQ
	MONITOR TERRESTRIAL HABITAT
	Acres monitored

	
	
	100%
	MR
	MONITOR SPECIES POPULATIONS
	Populations monitored

	M1.G1.S2.03
	Number of (stream/shoreline) miles of habitat restored or enhanced that directly support ESA listed and bureau sensitive species conservation or recovery. (Bureau measure)
	Support Measure - No Cost

	M1.G1.S2.04
	Number of acres of habitat restored or enhanced that directly support ESA listed and bureau sensitive species conservation or recovery. (Bureau measure)
	Support Measure - No Cost

	M1.G2
	Protect America's Cultural and Heritage Resources

	M1.G2.S1
	Protect cultural and historical assets and resources

	M1.G2.S1.01
	Percent of archaeological sites on DOI inventory in good condition. (SP)
	100%
	AE
	HERITAGE RESOURCES EDUCATION AND OUTREACH
	Number of programs/events delivered

	
	
	100%
	AJ
	CONSULTATIONS WITH INDIAN TRIBES AND ALASKA NATIVE CORPORATIONS
	Number of Consultations

	
	
	100%
	AR
	INTENTIONAL EXCAVATION OR INADVERTENT DISCOVERY OF NAGPRA ITEMS ON THE PUBLIC LANDS
	Transfers of custody

	
	
	100%
	BC
	ACRES OF HERITAGE RESOURCE INVENTORIED
	Acres Inventoried

	
	
	100%
	FB
	PERMITS ISSUED AUTHORIZING HERITAGE RESOURCE INVESTIGATIONS
	Permits processed

	
	
	100%
	FD
	HERITAGE RESOURCES INTENSIVELY RECORDED, EVALUATED AND STUDIED
	Number of properties for which data recovery, recordation and other field studies were conducted

	
	
	100%
	HF
	HERITAGE RESOURCES STABILIZED, MANAGED AND PROTECTED
	Properties protected or restored

	
	
	100%
	MY
	HERITAGE RESOURCES MONITORED
	Localities monitored

	M1.G2.S1.02
	Percent of historic structures on DOI inventory in good condition. (SP)
	100%
	CG
	HISTORIC STRUCTURES INTENSIVELY RECORDED, EVALUATED AND STUDIED
	Number of historic structures for which data recovery, recordation and other field studies were conducted

	
	
	100%
	KO
	HISTORIC STRUCTURES PROTECTED, STABILIZED, OR RESTORED
	Historic structures protected, stabilized, or restored

	
	
	100%
	LD
	HISTORIC STRUCTURES MONITORED
	Historic structures monitored

	M1.G2.S1.03
	Percent of collections in DOI inventory in good condition. (SP)
	100%
	AK
	INVENTORY AND REPATRIATE NAGPRA ITEMS IN COLLECTIONS
	Repatriations

	
	
	100%
	BD
	HERITAGE COLLECTIONS ACCESSIONED, INVENTORIED OR UPGRADED IN NON-BLM FACILITIES
	Number of accessions

	
	
	100%
	BW
	MUSEUM COLLECTIONS ACCESSIONED, INVENTORIED OR UPGRADED IN BLM FACILITIES
	Accessions Cataloged

	M1.G2.S1.04
	Percent of paleontological localities in DOI inventory in good condition. (Bureau measure)
	Support Measure - No Cost

	M1.G2.S1.07
	Miles of national scenic and historic trail inventory completed to standards
	100%
	CE
	INVENTORY NATIONAL SCENIC AND HISTORIC TRAILS
	Miles of inventory data collected, assessed, and documented to standard.

	M1.G2.S1.08
	Miles of national scenic and historic trail monitoring completed to standards
	100%
	LA
	MONITOR NATIONAL SCENIC AND HISTORIC TRAILS
	Miles monitored

	M1.G2.S1.09
	Percent of designated Wild and Scenic River miles achieving goals, objectives, and desired conditions in maintaining, protecting, and/or enhancing river-related values
	100%
	BE
	INVENTORY FOR WILDERNESS CHARACTER
	Acres Inventory

	
	
	100%
	DC
	PREPARE WILDERNESS/WSR/NSHT/CULTURAL/PALEONTOLOGICAL ACTIVITY PLANS
	New or revised activity plans completed

	
	
	100%
	MD
	MONITOR WILDERNESS AND WILDERNESS STUDY AREAS
	Acres monitored

	M1.G2.S1.10
	Percent of acres of Wilderness areas under BLM management meeting their heritage resource objectives under the authorizing legislation
	100%
	BZ
	INVENTORY DESIGNATED WILD AND SCENIC RIVERS
	Miles of baseline data collected and analyzed

	
	
	100%
	MF
	MONITOR DESIGNATED WILD AND SCENIC RIVERS
	Miles monitored

	M1.G3
	Provide Recreation and Visitor Experience

	M1.G3.S1
	Provide visitor services

	M1.G3.S1.01
	Percent of visitors satisfied with the quality of their experience. (SP)
	100%
	BA
	INVENTORY RECREATION RESOURCES
	Acres for which baseline information is collected and analyzed

	
	
	100%
	BY
	INVENTORY LINEAR RECREATION RESOURCES
	Miles of baseline information collected and analyzed

	
	
	100%
	DA
	PREPARE AND REVISE RECREATION ACTIVITY PLANS
	Plans completed

	
	
	100%
	EA
	PROCESS SRP’S FOR COMMERCIAL USERS AND GROUPS
	Permits administered

	
	
	100%
	EB
	ISSUE AND MANAGE RECREATION USE PERMITS
	Permits Administered

	
	
	100%
	FH
	PROCESS AND MANAGE SRPS NON COMMERCIAL
	Permits authorized

	
	
	100%
	MA
	MONITOR RECREATION AREAS
	Acres monitored

	
	
	100%
	MV
	MONITOR LINEAR RECREATION MANAGEMENT OBJECTIVES
	Miles monitored

	M1.G3.S1.02
	Percent satisfaction among visitors served by facilitated programs (SP)
	100%
	AL
	PROVIDE OUTREACH THROUGH INTERPRETATION AND ENVIRONMENTAL EDUCATION
	Programs/Events Delivered

	M1.G3.S1.03
	Percent of customers satisfied with the value for fee paid. (Bureau Measure)
	100%
	FV
	ADMINISTER THE RECREATION FEE PROGRAM
	Number of Fee Sites Managed

	M1.G3.S1.04
	Percent of recreation fee program receipts spent on fee collection. (Bureau Measure)
	100%
	FU
	MANAGE FEE COLLECTION PROGRAM FOR RECREATION USE PERMITS (RUP) AND SPECIAL RECREATION PERMITS (SRP)
	Number of fee sites managed

	M1.G4
	Manage the Impacts of Wildland Fire

	M1.G4.S1
	Establish fire-adapted ecosystems

	M1.G4.S1.01
	Percent of acres treated which are moved toward the desired condition class
	50%
	JQ
	IMPLEMENT FUELS TREATMENT MECHANICALLY OUTSIDE OF WUI
	Acres treated

	
	
	50%
	JR
	IMPLEMENT FUELS TREATMENT BY OTHER MEANS
	Acres treated

	
	
	50%
	JT
	REDUCE FUELS MECHANICALLY WUI
	Acres treated

	
	
	50%
	JU
	REDUCE HAZARDOUS FUELS OTHER WUI
	Acres treated

	
	
	50%
	JW
	IMPLEMENT FUELS TREATMENTS BY FIRE WITHIN WUI
	Acres treated

	
	
	100%
	LC
	MONITOR FUELS TREATMENT IN WILDLAND URBAN INTERFACE
	Acres monitored

	
	
	50%
	MT
	MONITOR FUELS TREATMENT NON-WILDLAND URBAN INTERFACE
	Acres monitored

	M1.G4.S1.02
	Percent of acres treated which are maintained in the desired condition class
	100%
	JL
	APPLY FIRE REHAB TREATMENTS
	Acres rehabilitated

	
	
	100%
	JS
	STABILIZE BURNED AREAS
	Acres stabilized

	
	
	100%
	MZ
	MONITOR POST-FIRE EMERGENCY STABILIZATION AND REHAB TREATMENTS
	Acres monitored

	M1.G4.S2
	Adapt communities to wildfires

	M1.G4.S2.01
	Percent of acres treated which achieve fire management objectives as identified in applicable management plans
	100%
	JM
	IMPLEMENT FUELS TREATMENT BY FIRE OUTSIDE WUI
	Acres treated

	
	
	50%
	JQ
	IMPLEMENT FUELS TREATMENT MECHANICALLY OUTSIDE OF WUI
	Acres treated

	
	
	50%
	JR
	IMPLEMENT FUELS TREATMENT BY OTHER MEANS
	Acres treated

	
	
	50%
	JT
	REDUCE FUELS MECHANICALLY WUI
	Acres treated

	
	
	50%
	JU
	REDUCE HAZARDOUS FUELS OTHER WUI
	Acres treated

	
	
	50%
	JW
	IMPLEMENT FUELS TREATMENTS BY FIRE WITHIN WUI
	Acres treated

	
	
	50%
	MT
	MONITOR FUELS TREATMENT NON-WILDLAND URBAN INTERFACE
	Acres monitored

	M1.G4.S3
	Respond to wildfires

	M1.G4.S3.01
	Percent of unplanned and unwanted wildfires on DOI lands that are controlled during initial attack
	100%
	AM
	PROVIDE RURAL FIRE AND COMMUNITY ASSISTANCE
	The number of departments that received benefits - new or updated apparatus (fire equipment), training, other equipment (radios)

	
	
	100%
	DD
	PLAN FOR PUBLIC HEALTH/SAFETY AND PROPERTY PROTECTION
	New or revised activity plans completed

	
	
	100%
	HT
	ENSURE FIRE PREPAREDNESS
	Administrative units that successfully passed preparedness reviews

	
	
	100%
	HU
	MANAGE WILDLAND FIRE
	Acres burned

	M1.PG1
	By the end of 2012, for 50% of the nation, the Department will identify resources that are particularly vulnerable to climate change and implement coordinated adaptation response actions.

	M1.PG1.01
	Number of regions with completed vulnerability assessments.
	Support Measure - No Cost

	M1.PG1.02
	Number of regions implementing climate change adaptation actions.
	Support Measure - No Cost

	M2
	Sustainably Manage Energy, Water, and Natural Resources


	M2.G1
	Secure America's Energy Resources


	M2.G1.S1
	Ensure environmental compliance and safety of energy development

	M2.G1.S1.01
	Percent of oil and gas acres reclaimed to appropriate final land condition. (SP)
	100%
	MW
	CONDUCT FLUID MINERAL SURFACE AND ENVIRONMENTAL MONITORING
	Sites Monitored

	M2.G1.S1.02
	Percent of producing fluid mineral cases that have a completed inspection during the year. (SP)
	100%
	NB
	CONDUCT FLUID MINERAL INSPECTION AND ENFORCEMENT
	Inspections completed

	
	
	100%
	OC
	CONDUCT INSPECTIONS ON GEOPHYSICAL EXPLORATION AUTHORIZED BY NOTICE OF INTENT (43 CRF 3150)
	Number of inspection actions completed

	M2.G1.S1.03
	Percent of required coal inspection and enforcement reviews completed. (Bureau Measure)
	100%
	NG
	INSPECT COAL OPERATIONS AND VERIFY PRODUCTION
	Inspections and production verifications completed

	M2.G1.S1.04
	Percent of Federal oil and gas lease assignments processed
	100%
	EI
	DEVELOP AND ISSUE FEDERAL FLUID MINERAL LEASES
	Leases issued, renewed, or exchanged

	
	
	100%
	FI
	PROCESS ADMINISTRATIVE CHANGES POST LEASE FEDERAL FLUID MINERALS
	Post lease actions or adjustments processed

	
	
	100%
	FK
	PROCESS INDIAN PRE-LEASE ACTIONS FOR ENERGY MINERALS
	Pre-lease actions processed

	M2.G1.S2
	Develop Renewable Energy Potential

	M2.G1.S2.01
	Number of megawatts of approved capacity authorized on public land and the OCS for renewable energy development while ensuring full environmental review. (SP)
	100%
	FX
	PROCESS RENEWABLE ENERGY (WIND/SOLAR) AUTHORIZATIONS
	Applications

	
	
	100%
	KH
	CONDUCT COMPETITIVE RENEWABLE ENERGY ACTIONS
	Number of Acres Leased

	
	
	100%
	KI
	PROCESS RENEWABLE ENERGY ACTIONS
	Actions Processed

	
	
	100%
	OD
	CONDUCT RENEWABLE ENERGY (WIND/SOLAR) COMPLIANCE
	Compliance actions

	M2.G1.S3
	Manage conventional energy development

	M2.G1.S3.01
	Percent of coal lease applications processed. (SP)
	100%
	EL
	PROCESS COAL LEASES AND EXPLORATION LICENSES
	Actions Processed

	
	
	100%
	GA
	COST RECOVERY - COMPETITIVE COAL LEASE
	Actions Processed

	M2.G1.S3.02
	Percent of pending fluid minerals Applications for Permit to Drill (APDs) which are processed. (SP)
	100%
	EJ
	PROCESS FLUID MINERALS APDS
	APDs Processed

	
	
	100%
	FJ
	PROCESS FLUID MINERALS SUNDRY NOTICES
	Notices processed

	
	
	100%
	FT
	PROCESS GEOPHYSICAL LEASES / PERMITS / LICENSES
	Actions Processed

	M2.G1.S3.03
	Number of coal post leasing actions approved for energy minerals. (Bureau Measure)
	100%
	EM
	PROCESS COAL POST LEASE ACTIONS
	Post lease actions processed

	
	
	100%
	GB
	COST RECOVERY - COAL LEASE MODIFICATION
	Coal lease modifications processed

	
	
	100%
	GC
	COST RECOVERY COAL – LMU FORMATION OR MODIFICATION
	Coal logical mining unit formation or processed

	
	
	100%
	GD
	COST RECOVERY COAL – ROYALTY RATE REDUCTION
	Coal royalty rate reductions processed

	M2.G1.S3.04
	Percent of pending cases of right-of-way permits and grant applications in backlog status. (Bureau Measure)
	100%
	EQ
	PROCESS LEASES, PERMITS, LICENSES, AND EASEMENTS
	Actions Processed

	
	
	100%
	ER
	PROCESS RIGHT-OF-WAY GRANTS
	Actions Processed

	
	
	100%
	FN
	SUPPORT HYDROPOWER LICENSING
	License issuances supported

	
	
	100%
	FP
	PROCESS RIGHT-OF-WAY ACTIONS OTHER THAN GRANTS
	Actions Processed

	
	
	100%
	NH
	CONDUCT REALTY COMPLIANCE INSPECTIONS
	Compliance actions

	M2.G1.S3.05
	Percent of oil and gas Reservoir Management Agreements processed. (Bureau Measure)
	100%
	FF
	PROCESS O&G RESERVOIR MGT AGREEMENTS
	Reviews processed

	
	
	100%
	NC
	RESOLVE FLUID MINERAL DRAINAGE CASES
	Drainage cases resolved

	M2.G3
	Sustainably Manage Timber, Forage, and Non-Energy Minerals

	M2.G3.S1
	Manage timber and forest products resources

	M2.G3.S1.01
	Percent of allowable sale quantity timber offered for sale consistent with applicable resource management plans. (SP)
	100%
	HD
	MANAGE FOREST AND WOODLAND COMMERCIAL SALES
	Acres managed – equal to acres yarded reported in the TSIS

	M2.G3.S1.02
	Volume of wood products offered consistent with applicable management plans (O&C and Public Domain) (SP)
	100%
	EG
	PREPARE VEGETATIVE PERMITS/CONTRACTS
	Permits/contracts issued

	M2.G3.S1.03
	Administrative cost per thousand board feet of timber offered for sale. (Bureau Measure)
	Support Measure - No Cost

	M2.G3.S1.04
	Volume of wood products offered (biomass for energy) consistent with applicable management plans. (Bureau Measure)
	100%
	HE
	BIOMASS UTILIZATION
	Tons of biomass offered

	M2.G3.S1.05
	Percent of forestry improvements (acres) completed as planned. (Bureau Measure)
	100%
	HL
	APPLY COMMERCIAL FOREST AND WOODLAND MANAGEMENT
	Acres restored / developed

	M2.G3.S2
	Provide for sustainable forage and grazing

	M2.G3.S2.01
	Percent of grazing permits and leases processed as planned consistent with applicable resource management plans. (SP)
	100%
	ED
	TRANSFER GRAZING PREFERENCES
	Transfers processed

	
	
	100%
	EE
	ISSUE GRAZING PERMITS/LEASES
	Grazing Permits / Leases Processed

	M2.G3.S2.02
	Number of grazing administration actions conducted
	100%
	EF
	ISSUE GRAZING BILLS
	Grazing Bills issued

	
	
	100%
	NA
	INSPECT ALLOTMENTS FOR GRAZING AUTHORIZATION COMPLIANCE
	Inspection of Grazing Authorization

	
	
	100%
	NJ
	PROCESS SURFACE TRESPASS/UNAUTHORIZED OCCUPANCY CASES
	Cases Processed

	M2.G3.S3
	Manage non-energy mineral development

	M2.G3.S3.01
	Percent of non-energy mineral exploration and development requests processed. (SP)
	100%
	BB
	ASSESS ALASKA MINERALS
	Sites Investigated

	
	
	100%
	EN
	PROCESS NON-ENERGY MINERAL LICENSES, PERMITS OR LEASES
	Licenses, permits, leases processed

	
	
	100%
	EO
	PROCESS NON-ENERGY MINERAL POST LEASE ACTIONS
	Post lease actions processed

	
	
	100%
	FS
	PROCESS INDIAN PRE-LEASE ACTIONS FOR NON-ENERGY MINERALS
	Actions processed

	
	
	100%
	GE
	COST RECOVERY NON-ENERGY MINERALS – PROSPECTING PERMIT APPLICATIONS
	Non-energy minerals prospecting permits processed

	
	
	100%
	GF
	COST RECOVERY NON-ENERGY MINERALS – PREFERENCE RIGHT LEASE APPLICATIONS
	Non-energy minerals preference rights lease applications processed

	
	
	100%
	GH
	COST RECOVERY NON-ENERGY MINERALS - COMPETITIVE LEASE
	Leases processed

	
	
	100%
	GI
	COST RECOVERY NON-ENERGY MINERALS - APPLICATION TO SUSPEND, WAIVE OR REDUCE RENTAL, MINIMUM ROYALTY, OR PRODUCTION ROYALTY RATE
	Actions processed

	
	
	100%
	GJ
	COST RECOVERY NON-ENERGY MINERALS - FUTURE OR FRACTIONAL INTEREST LEASE
	Non-energy minerals future interest leases or fractional interest leases processed

	M2.G3.S3.02
	Number of mined acres reclaimed to appropriate land condition and water quality standards. (SP)
	Support Measure - No Cost

	M2.G3.S3.03
	Percent of Mineral Material permits and contracts processed for non-energy minerals. (Bureau Measure)
	Support Measure - No Cost

	M2.G3.S3.04
	Average 3 year rolling costs of Mineral Materials disposals, inspections and trespass protection divided by the cubic yards disposed. (Bureau Measure)
	100%
	EP
	PROCESS MINERAL MATERIAL DISPOSALS THROUGH SALES
	Contracts issued

	
	
	100%
	FW
	PROCESS MINERAL MATERIAL DISPOSALS THROUGH PERMITS
	Permits

	
	
	100%
	GK
	COST RECOVERY MINERAL MATERIALS - NONCOMPETITIVE SALE
	Non-competitive sales

	
	
	100%
	GL
	COST RECOVERY MINERAL MATERIALS - COMPETITIVE SALE
	Non-competitive contracts and permits

	
	
	100%
	GM
	COST RECOVERY MINERAL MATERIALS CONTRACT RENEWAL
	Contracts

	M2.G3.S3.05
	Percent of Reclamation Bond Adequacy. (Bureau Measure)
	Support Measure - No Cost

	M2.G3.S3.06
	Average time for processing plans of operation for locatable minerals. (Bureau Measure)
	100%
	EX
	PROCESS MINING PLANS OF OPERATION
	Plans processed

	
	
	100%
	GN
	COST RECOVERY MINING LAW ADMINISTRATION - PLAN OF OPERATIONS WITH AN EIS
	Plans processed

	M2.G3.S3.07
	Percent of Notices and Plans of Operations Inspected. (Bureau Measure)
	100%
	NI
	INSPECT LOCATABLE MINERAL SITES FOR SURFACE MANAGEMENT COMPLIANCE
	Inspections completed

	M2.G3.S3.08
	Percent of Mineral Materials Trespass actions resolved for non-energy minerals. (Bur/PART)
	100%
	OE
	SUBSURFACE MINERAL TRESPASS
	Cases Processed

	M2.G3.S3.09
	Number of mining notices processed. (Bureau Measure)
	100%
	EW
	RECORD/ADJUDICATE MINING CLAIMS/SITES
	Claims / Sites recorded / adjudicated

	
	
	100%
	EY
	DETERMINE MINING CLAIM VALIDITY/PROCESS MINERAL PATENTS
	Reports, patents, complaints processed

	
	
	100%
	EZ
	COLLECT MINING CLAIM/SITE FEE
	Claims/sites where fees were collected

	
	
	100%
	FL
	PROCESS MINING NOTICES
	Notices Processed

	
	
	100%
	FY
	RECORD/ADJUDICATE SURFACE MANAGEMENT BONDS
	Bonds adjudicated

	
	
	100%
	GO
	COST RECOVERY MINING LAW ADMINISTRATION – VALIDITY & MINERAL EXAMINATIONS AND REPORTS
	Mineral examinations and reports completed

	M2.G3.S3.10
	Cumulative percent of original helium debt repaid at end of fiscal year. (Bureau Measure)
	Support Measure - No Cost

	M2.G3.S3.11
	Percent of time the Crude Helium Enrichment Unit (CHEU) was operating during the fiscal year. (Bureau Measure)
	100%
	EK
	MANAGE HELIUM
	Sales of helium

	M2.G3.S3.12
	Number of Mineral Material Inspections and Production Verifications
	100%
	NF
	INSPECT, AND VERIFY PRODUCTION AT MINERAL MATERIAL SITES
	Inspection and production verification reports completed

	M2.G3.S3.13
	Number of Non-energy Solid Mineral Inspections and Production Verifications
	100%
	OB
	INSPECT AND VERIFY PRODUCTION AT SOLID LEASABLE MINERAL SITES - NON ENERGY
	Inspection and production verifications completed

	M2.PG2
	Increase approved capacity for production of renewable energy resources on DOI managed lands, while ensuring full environmental reviews, by at least 9,000 megawatts through 2011, and an additional 1,000 mw through the end of FY 2012

	M2.PG2.01
	Number of megawatts of approved capacity authorized on public land for renewable energy development while ensuring full environmental review
	Support Measure - No Cost

	M5
	Building a 21st Century Department of the Interior

	M5.G5
	Improving Acquisition and Real Property Management

	M5.G5.S1
	Effective Management of facilities

	M5.G5.S1.01
	Percent of buildings maintained in adequate condition, determined by FCI
	100%
	IA
	RECREATION SITE BUILDING ANNUAL MAINTENANCE
	Number of Buildings Maintained

	
	
	100%
	IM
	ADMINISTRATIVE SITE BUILDING ANNUAL MAINTENANCE
	Number of Buildings Maintained

	M5.G5.S1.02
	Percent of sites maintained in adequate condition, determined by FCI
	100%
	GS
	ADMINISTRATIVE SITE CONDITION ASSESSMENT
	Number of Administrative Sites Assessed

	
	
	100%
	GT
	RECREATION SITE CONDITION ASSESSMENT
	Recreation Sites Assessed

	
	
	100%
	GW
	DAM CONDITION ASSESSMENT
	Dams Assessed

	
	
	100%
	GX
	BRIDGE CONDITION ASSESSMENT
	Bridges Assessed

	
	
	100%
	GY
	TRAIL CONDITION ASSESSMENT
	Miles

	
	
	100%
	ID
	TRAIL ANNUAL MAINTENANCE
	Miles Maintained

	
	
	100%
	IG
	BRIDGE ANNUAL MAINTENANCE
	Bridges Maintained

	
	
	100%
	IJ
	DAM ANNUAL MAINTENANCE
	Dams Maintained

	
	
	100%
	IU
	RECREATION SITE NON-BUILDING ANNUAL MAINTENANCE
	Number of Sites Maintained

	
	
	100%
	IY
	ADMINISTRATIVE SITE NON-BUILDING ANNUAL MAINTENANCE
	Number of Sites Maintained

	M5.G5.S1.03
	Number of lane miles of roads maintained in adequate condition. (Bur)
	100%
	GU
	ROAD CONDITION ASSESSMENT
	Lane Miles

	
	
	100%
	IP
	ROAD ANNUAL MAINTENANCE
	Lane Miles Maintained

	M5.G5.S1.04
	Percent of Deferred Maintenance and Construction projects completed
	100%
	IB
	FACILITIES DEFERRED MAINTENANCE AND CONSTRUCTION
	Number of Projects

	
	
	100%
	IE
	TRAIL DEFERRED MAINTENANCE AND CONSTRUCTION
	Number of Projects

	
	
	100%
	IH
	BRIDGE DEFERRED MAINTENANCE AND CONSTRUCTION
	Number of Projects

	
	
	100%
	IK
	DAM DEFERRED MAINTENANCE AND CONSTRUCTION
	Number of Projects

	
	
	100%
	IQ
	ROAD DEFERRED MAINTENANCE AND CONSTRUCTION
	Number of Projects

	M5.G5.S1.05
	Percent of Construction projects completed
	Support Measure - No Cost

	M5.G5.S1.06
	Facility Compliance: Increase the percentage of BLM organizational units rated in good safety, health, and environmental condition. (CASHE - Bureau Measure)
	Support Measure - No Cost

	M5.G5.S1.07
	Number of public land title records posted on the internet to assist title, survey, historical, and genealogical research and retrieval. (Bureau Measure)
	100%
	BL
	COLLECT DIGITAL CADASTRAL DATA
	Number of Townships

	
	
	100%
	BM
	UPDATE DIGITAL CADASTRAL DATA
	Number of Townships

	
	
	100%
	BX
	MANAGE PUBLIC LAND RECORDS
	Records created or updated

	
	
	100%
	ET
	PROCESS WITHDRAWAL ACTIONS
	Acres Withdrawn

	
	
	100%
	FQ
	PROCESS WITHDRAWAL REVOCATIONS AND OTHER SIMILAR ACTIONS
	Acres Reviewed

	M5.G5.S1.08
	Percent of survey projects of Federal and Indian Trust lands that are funded (Bur/PART)
	100%
	AP
	BLM INDIAN LANDS SURVEYORS CONSULTING SERVICES
	Number of consultations provided

	
	
	100%
	AQ
	BOUNDARY STANDARD DOCUMENTS PRODUCED
	Number of Standards for Boundary Evidence certificates

	
	
	100%
	BJ
	APPROVE CADASTRAL SURVEYS
	Cadastral Survey Miles Approved

	
	
	100%
	BK
	COMPLETE CADASTRAL FIELD MILES SURVEY
	Miles Completed

	M5.G5.S1.09
	Percent of cadastral surveys approved within eighteen months of the funding date. (Bur/PART)
	Support Measure - No Cost

	M5.G5.S1.10
	Percent of land patented to the State and Alaskan Native Corporations as required by statute. (Bur/PART)
	100%
	HM
	PROCESS ALASKA NATIVE ALLOTMENT CONVEYANCES
	Parcels Patented

	
	
	100%
	HX
	PATENT ALASKA STATE CONVEYANCES
	Acres Patented

	
	
	100%
	HY
	PATENT ALASKA NATIVE CORP CONVEYANCES
	Acres Patented

	
	
	100%
	KA
	PROCESS ALASKA NATIVE ALLOTMENT SELECTIONS
	Parcels approved, and parcels processed but not approved

	
	
	100%
	KB
	CONVEY ALASKA STATE SELECTIONS
	Acres Conveyed by Tentative Approval

	
	
	100%
	KC
	CONVEY ALASKA NATIVE CORPORATION SELECTIONS
	Acres Conveyed by Interim Conveyance

	M5.G5.S1.11
	Increase the acreage of land disposals and conveyances completed outside Alaska. (Bur/PART)
	100%
	DW
	PLAN PRE-PROPOSAL RESERVE COST
	Pre-Proposal Planning (PPP) studies conducted

	
	
	100%
	ES
	PROCESS R&PP LEASES
	Acres Leased

	
	
	100%
	FM
	PROCESS LAND EXCHANGES
	Acres disposed in exchange

	
	
	100%
	FR
	PROCESS LAND DISPOSALS OTHER THAN SALES
	Acres Disposed

	
	
	100%
	KP
	TITLE AND BOUNDARY CONFLICTS RESOLVED
	Title and boundary conflicts resolved

	M5.G5.S1.12
	Increase the number and acreage of land exchanges and acquisitions to improve land tenure distribution. (Bur/PART)
	100%
	FO
	PROCESS LAND EXCHANGES - ACQUISITIONS
	Acres acquired in exchange

	
	
	100%
	HN
	PROCESS LAND PURCHASE/DONATION
	Number of acres purchased or donated

	
	
	100%
	KD
	PROCESS LAND DISPOSALS AND LAND PURCHASE, DONATION, OR EXCHANGE
	Acres processed but lands not disposed of or acquired

	M5.G5.S1.13
	Percentage of total acreage of land sales offered by competitive or modified competitive means. (Bur/ PART)
	100%
	EU
	PROCESS LAND SALES
	Acres Disposed



Source:  http://abc.blm.gov/prodABC/reference/refPMs.asp
Another format (7 pp):   http://abc.blm.gov/images/Performance-Measures-2012.pdf


[bookmark: _Toc342482712]FY12 Program Element List – Alphabetical Order 
	PE Code
	Name (unit of measure)
	
	
	
	
	
	
	

	

	AE
	Heritage Resources Education and Outreach (number of products delivered)

	AJ
	Consultations with Indian Tribes and Alaska Native Corp (number of consultations)

	AK
	Inventory, Repatriate and Transfer Custody of NAGPRA Items (number)

	AL
	Public Outreach Through Interpretation & Enviro Educ (programs/events delivered)

	AM
	Provide Rural Fire and Community Assistance (number of departments receiving benefits)

	AP
	Bureau of Land Management Indian Lands Surveyors Consulting Services (consultations)

	AQ
	Boundary Standard Documents Produced (number of certificates)

	AR
	Intentional Excavation or Inadvertent Discovery of NAGPRA Items

	BA
	Inventory Recreation Resources (acres)
	 
	 
	 
	 

	BB
	Alaska Mineral Land Assessment (number of sites investigated)
	 
	 

	BC
	Acres of Heritage Resource Inventories (Acres)
	 
	 
	 

	BD
	Heritage Collections, Accessioned, Inventoried or Upgraded in non-BLM Facilities (#)

	BE
	Inventory for Wilderness Character (acres)
	 
	 
	 
	 

	BF
	Assess Hazmat Sites (sites)
	 
	 
	 
	 
	 

	BG
	Assess Other Hazards (Non-Hazmat or AML) (number)
	 
	 

	BH
	Inventory Abandoned Mine Land Sites (sites)
	 
	 
	 

	BJ
	Approve Cadastral Surveys (miles)
	 
	 
	 
	 

	BK
	Complete Cadastral Field Miles Survey  (miles)
	 
	 
	 

	BL
	Collect Digital Cadastral Data (GCDB) (number of townships)
	 
	 

	BM
	Update Digital Cadastral Data (GCDB) (number of townships)
	 
	 

	BN
	Inventory Water Resources (number of inventory station parameters)
	 

	BO
	Inventory Soils Resources  (acres mapped)
	 
	 
	 
	 

	BP
	Watersheds Assessed (acres)
	 
	 
	 
	 
	 

	BQ
	Inventory of Ecological Sites (acres completed)
	 
	 
	 

	BR
	Inventory Shrub, Grassland/ PJ Vegetation  (acres)
	 
	 
	 

	BS
	Inventory for Presence Invasive Plants and/or Noxious Weed  (acres)
	 

	BT
	Inventory Forest/Woodland Vegetation  (acres)
	 
	 
	 

	BU
	Inventory Lakes/Wetland Areas  (acres)
	 
	 
	 
	 

	BV
	Inventory Streams/Riparian Areas  (miles)
	 
	 
	 
	 

	BW
	Museum Collections Accessioned, Inventoried or Upgraded in BLM Facilities (number)

	BX
	Manage Public Land Records (number)
	 
	 
	 
	 

	BY
	Inventory Linear Recreation Resources (miles)
	 
	 
	 

	BZ
	Inventory Designated Wild and Scenic Rivers (miles)
	 
	 
	 

	CB
	Inventory Wildlife/Plan Habitat (acres)

	CC
	Assessment or Prediction of Air Resource Conditions (number of actions completed)

	CD
	Assess Ecoregions (acres)

	CE
	Inventory National Scenic and Historic Trails (miles)

	CF
	Inventory Invasive Animal Populations

	CG
	Historic Structures Recorded, Evaluated, and Studied

	DA
	Prepare and Revise Recreation Activity Plans (number)
	 
	 

	DB
	Plan for Commercial Activities  (number)
	 
	 
	 
	 

	DC
	Prepare Wilderness/WSR/NSHT/Cultural/Paleontological Activity Plans (number)

	DD
	Plan for Public Health/Safety and Property Protection (number)
	 
	 

	DF
	Plan for Interdisciplinary Activities  (number)
	 
	 
	 

	DI
	Plan for Herd Management (number)
	 
	 
	 
	 

	DJ
	Evaluate Land Use Plans (number)
	 
	 
	 
	 

	DK
	Plan for Threatened & Endangered Recovery  (number)
	 
	 
	 

	DN
	Prepare Pre-Land Use Plan (number completed)
	 
	 
	 

	DO
	Complete Land Use Plan Scoping Report/Planning Criteria (number completed)

	DP
	Prepare Draft Land Use Plans (number completed)
	 
	 
	 

	DQ
	Prepare Proposed LUP/Final EIS (number completed)
	 
	 
	 

	DR
	Resolve Protest/Prepare Record of Decision (number completed)
	 
	 

	DS
	Prepare Draft EIS Level Land Use Plan Amendment (number completed)
	 

	DT
	Prepare Final LUP Amendment/Record of Decision (number completed)
	 

	DU
	Prepare EA Level LUP Amendment/Record of Decision (number completed)
	 

	DV
	Review Other Bureau Proposed Actions (Reviews Conducted)
	 
	 

	DW
	Plan Pre-Proposal Reserve cost (SNPLMA)
	 
	 
	 
	 

	DX
	Complete RMP Implementation Strategies (number completed)
	 
	 

	EA
	Process SRPs for Commercial Users & Groups (permits administered)
	 

	EB
	Issue & Manage Recreation Use Permits (permits administered)
	 
	 

	EC
	Process Water Rights Actions (number)
	 
	 
	 
	 

	ED
	Transfer Grazing Preferences (number)
	 
	 
	 
	 

	EE
	Issue Grazing Permits/Leases (permits processed)
	 
	 
	 

	EF
	Issue Grazing Bills (number)
	 
	 
	 
	 
	 

	EG
	Prepare Vegetative Permits/Contracts (number)
	 
	 
	 

	EI
	Develop and Issue Federal Fluid Mineral Leases (number)
	 
	 

	EJ
	Process Fluid Minerals APDs (number)
	 
	 
	 
	 

	EK
	Manage Helium (MMcf)
	 
	 
	 
	 
	 

	EL
	Process Coal Leases and Exploration Licenses (actions processed)
	 

	EM
	Process Coal Post Lease Actions (post lease actions processed)
	 
	 

	EN
	Process Non-Energy Mineral Licenses, Permits, or Leases (number processed)

	EO
	Process Non-Energy Mineral Post Lease Actions (number)
	 
	 

	EP
	Process Mineral Material Disposal Through Sales (number of contracts)
	 

	EQ
	Process Leases, Permits, Licenses, and Easements (actions processed)
	 

	ER
	Process Rights-of-Way Grants(number of actions)
	 
	 
	 

	ES
	Process Recreation & Public Purpose Leases (acres leased)
	 
	 

	ET
	Process Withdrawal Actions (acres withdrawn)
	 
	 
	 

	EU
	Process Land Sales (acres disposed of)
	 
	 
	 
	 

	EW
	Record/Adjudicate Mining Claims/Sites (number of claims/sites)
	 
	 

	EX
	Process Mining Plans of Operation (plans processed)
	 
	 
	 

	EY
	Determine Mining Claim Validity/Process/Mineral Patents (number)
	 

	EZ
	Collect Mining Claim/Site Fee (number of claims/sites)
	 
	 
	 

	FB
	Permits Issued Authorizing Heritage Resource Investigations (number)

	FD
	Heritage Resources Intensively Recorded, Evaluated and Studied (number)

	FF
	Process O&G Reservoir Management Agreements (number)

	FH
	Process & Manage SRP's for Non Commercial (number of permits issued/monitored)

	FI
	Process Admin Changes Post Lease Federal Fluid Minerals (actions)

	FJ
	Process Fluid Minerals Sundry Notices (number)

	FK
	Process Indian Pre-Lease Actions for Energy Minerals(number processed)

	FL
	Process Mining Notices (notices processed)

	FM
	Process Land Exchanges (acres disposed in exchange)

	FN
	Support Hydropower Licensing (number of licenses issued)

	FO
	Process Land Exchanges-Acquisitions (acres acquired in exchanges)

	FP
	Process Right-of-Way Actions Other than Grants (actions processed)

	FQ
	Process Withdrawal Revocations and Similar Actions (acres reviewed)

	FR
	Process Land Disposals Other than Sales (acres disposed)

	FS
	Process Indian Pre-Lease Actions for Non-Energy Minerals (actions processed)

	FT
	Process Geophysical Leases/ Permits / Licenses (actions processed)

	FU
	Manage Fee Collection Program for RUPs& SRPs (number of fee sites managed)

	FV
	Administer the Recreation Fee Program (number of fee sites managed)

	FW
	Process Mineral Material Disposals Through Permits (permits issued)

	FX
	Process Renewable Energy (Wind/Solar) Authorizations (actions processed) 

	FY
	Record/Adjudicate Financial Guarantee

	GA
	Cost Recovery - Competitive Coal Lease (actions processed)
	 
	 

	GB
	Cost Recovery - Coal Lease Modification ( number processed)
	 
	 

	GC
	Cost Recovery Coal - LMU Formation or Modif (number of apps processed)
	 

	GD
	Cost Recovery Coal - Royalty Rate Reduction (number processed)
	 

	GE
	Cost Recovery Non-Energy Min - Prospecting Permit Applications (number)
	 

	GF
	Cost Recovery Non-Energy Min – Preference Right Lease Apps (number)
	 

	GH
	Cost Recovery Non-Energy Minerals - Competitive Lease (number processed)
	 

	GI
	Application to Suspend, Waive or Reduce Rental, Minimum Royalty, or Product (number)

	GJ
	Cost Recovery Non-Energy Min - Future or Fractional Interest Lease (number)
	 

	GK
	Cost Recovery Mineral Materials - Noncompetitive Sale (number processed)
	 

	GL
	Cost Recovery Mineral Materials - Competitive Sale (number processed)
	 

	GM
	Cost Recovery Mineral Materials Contract Renewal (number processed)
	 

	GN
	Cost Recovery Mining Law Admin - Plan of Ops with an EIS (plans processed)

	GO
	Cost Rec M L Admin – Validity & Mineral Exams & Reports (number com/app)

	GS
	Administrative Site Condition Assessment (Administrative Sites Assessed)
	 

	GT
	Recreation Site Condition Assessment (Recreation Sites Assessed)
	 

	GU
	Road Condition Assessment (Lane Miles Assessed)
	 
	 
	 

	GW
	Dam Condition Assessment (Dams Assessed)
	 
	 
	 

	GX
	Bridge Condition Assessment (Bridges Assessed)
	 
	 
	 

	GY
	Trail Condition Assessment (Miles Assessed)
	 
	 
	 

	HD
	Manage Forest and Woodland Commercial Sales (acres)
	 
	 

	HE
	Biomass Utilization (tons)
	 
	 
	 
	 
	 

	HF
	Heritage Resources Stabilized, Managed and Protected (number)
	 
	 

	HG
	Adopt Wild Horses and Burros  (number of animals)
	 
	 
	 

	HH
	Long Term Hold WH&B (number of animal days)
	 
	 
	 

	HI
	Prepare/Hold Wild Horses and Burros  (number of animal days)
	 
	 

	HL
	Apply Commercial Forest and Woodland Management (acres)
	 
	 

	HM
	Process Alaska Native Allotment Conveyances (parcels patented)
	 
	 

	HN
	Process Land Purchase/Donation (number of acres purchased or donated)
	 

	HO
	Respond to Hazmat Risk Site (actions)
	 
	 
	 
	 

	HP
	Remediate AML Physical Safety Hazards (number of sites)
	 
	 

	HQ
	Mitigate Other Hazards  (number)
	 
	 
	 
	 

	HT
	Ensure Fire Preparedness (number of admin units passing review)
	 
	 

	HU
	Manage Wildland Fire (acres burned)
	 
	 
	 
	 

	HX
	Patent Alaska State Conveyances  (acres patented)
	 
	 
	 

	HY
	Patent Alaska Native Corp Conveyances  (acres)
	 
	 
	 

	IA
	Recreation Site Building Annual Maintenance (Number of Buildings Maintained)

	IB
	Facilities Deferred Maintenance and Construction (Number of Projects)

	ID
	Trail Annual Maintenance (Miles Maintained)

	IE
	Trail Deferred Maintenance and Construction (Number of Projects)

	IG
	Bridge Annual Maintenance (Bridges Maintained)

	IH
	Bridge Deferred Maintenance and Construction (Number of Projects)

	IJ
	Dam Annual Maintenance (Dams Maintained)

	IK
	Dam Deferred Maintenance and Construction (Number of Projects)

	IM
	Administrative Site Building Annual Maintenance (Number of Buildings Maintained)

	IN
	DELETED Admin Site Deferred Maintenance and Construction (Number of Projects)

	IP
	Road Annual Maintenance (Lane Miles Maintained)

	IQ
	Road Deferred Maintenance and Construction (Number of Projects)

	IU
	Recreation Site Non-Building Annual Maintenance (Number of Sites)

	IY
	Administrative Site Non-Building Annual Maintenance (Number of Sites Maintained)

	JA
	Apply Shrub/Grass Vegetation Treatments (acres)
	 
	 
	 

	JB
	Construct Shrub/Grass/PJ/Forest Projects (number)
	 
	 
	 

	JC
	Maintain Shrub/Grass/PJ/Forest Projects (number)
	 
	 
	 

	JD
	Apply Weed Treatments  (acres)
	 
	 
	 
	 

	JE
	Restore Forest and Woodland Through Sales (acres)
	 
	 
	 

	JF
	Apply Lake/Wetland Treatments (acres)
	 
	 
	 
	 

	JG
	Apply Stream/Riparian Treatments (miles)
	 
	 
	 
	 

	JH
	Construct Lake/Wetland/Stream/Riparian Projects (number of projects)
	 

	JI
	Maintain Lake/Wetland/Stream/Riparian Projects (projects maintained)
	 

	JJ
	Gather/Remove Wild Horses and Burros (number of animals removed)
	 

	JK
	Implement AML Projects to Restore Water Quality (acres)
	 
	 

	JL
	Apply Fire Rehab Treatments (acres)
	 
	 
	 
	 

	JM
	Implement Fuels Treatments Outside WUI Using Prescribed fire (acres treated)

	JN
	Restore Forest and Woodlands through Development (acres)
	 
	 

	JP
	Implement Threatened and Endangered Species Recovery Actions (number)
	 

	JQ
	Implement Fuels Treatment Mechanically outside of WUI (acres treated)
	 

	JR
	Implement Fuels Treatment by other means outside of WUI (acres treated)
	 

	JS
	Stabilize Burned Areas (acres stabilized)
	 
	 
	 
	 

	JT
	Reduce Fuels Mechanically within WUI (acres treated)
	 
	 
	 

	JU
	Reduce Hazardous Fuels by other means within WUI (acres treated)
	 

	JW
	Implement Fuels Treatments by prescribed fire Within the WUI (acres treated)

	JX
	Decommission and Rehabilitate Roads and Trails (miles)
	 
	 

	JZ
	Native Plant Materials Collection (number of collections)
	 
	 

	KA
	Process Alaska Nat Allotment Selections (parcels approved, processed unapproved)

	KB
	Convey Alaska State Selections (acres conveyed by tentative approval) )

	KC
	Convey Alaska Native Corporation Selections (acres conveyed by interim con)

	KD
	Process Land Sales, Purchase/Donation (Cases procd, lands not sold or acq)

	KE
	Implement Conservation Actions for Non-ESA Species and Communities

	KF
	Gather/Treat Wild Horses and Burros

	KG
	Wild Horse and Burro Population Growth Suppression

	KH
	Prepare and Conduct Competitive Renewable Energy (Wind/Solar) Actions

	KI
	Process Renewable Energy (Wind/Solar) Actions Other than Authorizations

	KO
	Historic Structures Protected, Stabilized, or Restored

	KP
	Number of Title and Boundary Conflicts Resolved

	LA
	Monitor Designated National Scenic and Historic Trails (miles)

	LB
	Monitor and Maintain AML Physical Safety Closures

	LC
	Monitor Fuels Treatment in Wildland Urban Interface

	LD
	Historic Structures Monitored

	MA
	Monitor Recreation Areas (acres)
	 
	 
	 
	 

	MB
	Evaluate Forest/Woodland Treatments  (acres)
	 
	 
	 

	MC
	Conduct Census WH&B Areas (number)
	 
	 
	 
	 

	MD
	Monitor Wilderness and Wilderness Study Areas (acres)
	 
	 

	MF
	Monitor Designated Wild and Scenic Rivers (miles)
	 
	 
	 

	MG
	Monitor and Maintain AML, HAZMAT and NRDAR Sites  (number of sites)
	 

	MI
	Monitor Air Quality and Climatic Conditions  (number of parameters collected)
	 

	MJ
	Evaluate Land Health  (evaluation reports)
	 
	 
	 
	 

	MK
	Evaluate Weed Treatments (acres)
	 
	 
	 
	 

	ML
	Monitor Grazing Allotments (number)
	 
	 
	 
	 

	MN
	Monitor Lake/Wetland Habitat  (acres evaluated)
	 
	 
	 

	MO
	Monitor Streams/Riparian Habitat  (miles)
	 
	 
	 
	 

	MP
	Monitor WH&B Herd Management Areas  (number)
	 
	 
	 

	MQ
	Monitor Terrestrial Habitat (acres)
	 
	 
	 
	 

	MR
	Monitor Species Populations  (number)
	 
	 
	 
	 

	MT
	Monitor Fuels Treatment  (acres)
	 
	 
	 
	 

	MU
	Monitor Water Resources  (number of monitoring station parameters)
	 

	MV
	Monitor Linear Recreation Management Objectives (miles)
	 
	 

	MW
	Conduct Fluid Mineral Surface and Environmental Monitoring (sites monitored)

	MX
	Monitor Shrub/Grass Vegetation Treatments (acres)
	 
	 
	 

	MY
	Heritage Resources Monitored  (number)
	 
	 
	 
	 

	MZ
	Monitor Post Fire Emergency Stabilization and Rehabilitation Treatments (acres)

	NA
	Inspect Allotments for Grazing Authorization Compliance (number)
	 
	 

	NB
	Conduct Fluid Mineral Inspection & Enforcement (# of inspections completed)
	 

	NC
	Resolve Fluid Mineral Drainage Cases (number)
	 
	 
	 

	NF
	Inspect, and Verify Production at Mineral Material Site (number)
	 
	 

	NG
	Inspect Coal Operations and Verify Production (number)
	 
	 

	NH
	Conduct Realty Compliance Inspections (number)
	 
	 
	 

	NI
	Inspect Locatable Mineral Sites for Surface Mgt Compliance (# of inspections)
	 

	NJ
	Process Trespass/Unauthorized Occupancy Cases (# of cases processed)
	 

	NK
	Conduct WH&B Compliance Inspections (number of animals)
	 
	 

	NP
	Evaluate PRPs for Cost Avoidance/Recovery (number)
	 
	 
	 

	NQ
	Process HAZMAT Cost Avoidance/Recovery Cases (number)
	 
	 

	NU
	Conduct Patrol Enforcement Activities (number of incidents reported)
	 

	NV
	Conduct Investigative Activities (incidents closed)
	 
	 
	 

	NY
	Conduct Emergency Response Activities (number of incidents resolved)
	 

	NZ
	Conduct Security Activities (number of vulnerability assessments)
	 
	 

	OA
	Conduct Drug Enforcement Activities (number of seizure incidents)

	OB
	Inspect & Verify Production at Solid Leasable Mineral Sites-Non Energy (#)

	OC
	Conduct Inspections on Geophysical Exploration Authorized by NOI (#)

	OD
	Conduct Renewable Energy (Wind/Solar) Compliance (compliance actions)

	OE
	Subsurface Mineral Trespass

	PC
	Provide Program Support; Natural/Cultural Heritage(none)
	 
	 

	PH
	Provide Program Support: Restore Health of Public Lands (none)
	 
	 

	PI
	Provide Program Support: Sustaining Biological Communities (none)
	 

	PJ
	Provide Program Support: Forest Products (none)
	 
	 
	 

	PK
	Provide Program Support: Forage (none)
	 
	 
	 
	 

	PM
	Provide Program Support: Quality Recreational Experience (none)
	 
	 

	PN
	Provide Program Support: Protection of Lives, Resources, and Property (none)

	PO
	Public Resources - Non-Energy (none)
	 
	 
	 
	 

	PP
	Provide Program Support: Public Resources -  Energy (none)
	 
	 

	PQ
	Provide Program Support: Renewable Energy (none)
	 
	 
	 

	RA
	Revenue Billings and Collections (none) 
	
	
	
	

	RB
	National Gas Royalties and Sales (none)
	
	
	
	

	RD
	Payroll Deduction - Meals (none)
	
	
	
	

	RH
	Revenue Billings and Collections (none) 
	
	
	
	

	XA
	Plan and Develop IT Systems (none)
	 
	 
	 
	 

	XB
	Provide IT Hardware/Software Installation, Upgrade, and Training (none)
	 

	XC
	Implement and Maintain Communication Networks (none)
	 
	 

	XD
	Provide IT Operations and Maintenance (none)
	 
	 
	 

	XE
	Provide Data Administration (none)
	 
	 
	 
	 

	XF
	Ensure IT Security (none)
	 
	 
	 
	 
	 

	XG
	Provide Facilities and Space Management Services (none)
	 
	 

	XH
	Manage Records/Central Files/Mailroom/Library/Directives Operations (none)
	 

	XI
	Process Payments, Billings and Collections (none)
	 
	 
	 

	XJ
	Maintain Agency Financial System and Reporting Requirements (none)
	 

	XK
	Manage Procurement, Acquisition and Agreement Activities (none)
	 

	XL
	Provide Personnel Services (none)
	 
	 
	 
	 

	XM
	Provide Employee Development and Training Services (none)
	 
	 

	XN
	Administer Internal Civil Rights (none)
	 
	 
	 
	 

	XO
	Provide Safety Program Services (none)
	 
	 
	 
	 

	XP
	Conduct Management Analysis and Studies (none)
	 
	 
	 

	XQ
	Administer External Civil Rights (none)
	 
	 
	 
	 

	XR
	Provide IT Support (none)
	 
	 
	 
	 
	 

	XS
	Prepare Financial Management Reports (none)
	 
	 
	 

	XT
	Administer Employee and Labor Relations (none)
	 
	 
	 

	XV
	Manage and Support Radio Communications Program (none)
	 
	 

	XW
	Conduct Budget Formulation/Execution and Cost Management Activities (none)

	XX
	Provide Strategic Leadership (none)
	 
	 
	 
	 

	XZ
	Provide Personal Property, Vehicle Fleet Mgt Services & Other Mgt Support Services (none)

	
	 
	
	
	
	
	
	
	




[bookmark: _Toc342482713]Excel Tips and Tricks 

Opening a Workbook
1. Click on the File tab.
2. Select Open in the left pane.
3. Locate and select the file you want to open.
4. Click the Open button.
Opening a Recent Workbook
1. Click on the File tab.
2. Select Recent in the left pane.
3. Select the document in the Recent Workbooks pane.
Saving a Workbook
1. There are 3 ways to save the document as an Excel 2007 or Excel 2010 file:
a. Click on the File tab, then Select Save from the left panel.  OR
b. Click on the Save icon button on the Quick Access Toolbar across the top.  OR
c. Click on Ctrl + S.
2. Select the location where you want to save the workbook.
3. Enter a file name in the File name box.
4. Click the Save button.
Color-Coding a Worksheet Tab
1. Select the worksheet.
2. Click on the Home tab.
3. Click the Format button in the Cells group.
4. Select Tab Color and select a color from the color palette.
Selecting Rows or Columns
1. To select an entire row or column, click the row or column heading (4 or K, for example)
2. To select a range of rows or columns, click and drag the mouse pointer over the row or column headings.
3. To select non-adjacent rows or columns, hold the Ctrl key and click on each row or column heading.
Inserting a Row (or column)
1. Select the row heading below (or column heading to the right) of where you want to insert the row. (to insert multiple rows, select the same number of rows you want to insert)
2. Click on the Home tab.
3. Click the arrow on the Insert Cells button in the Cells group.
4. Select Insert Sheet Rows from the menu.
5. Follow the same process for inserting columns.
Deleting a Row (or column)
1. Select the row heading you want to delete. (to delete multiple rows, select the same number of rows you want to delete)
2. Click on the Home tab.
3. Click the arrow on the Delete Cells button in the Cells group.
4. Select Delete Sheet Rows from the menu.
5. Follow the same process for inserting columns.
Adjusting Row Height or Column Width
1. Select the row(s) or column(s) you want to adjust.
2. Click on the Home tab and do any of the following:
a. To adjust using the mouse: Place mouse pointer over the boundary line of a row or column heading until it turns into a double-sided arrow.  Click and drag the boundary to adjust it.  OR
b. To adjust to fit cell data:  Click the Format button in the Cells group and select AutoFit Row Height or AutoFit Column Width.  
c. To set a precise height or width: Click the Format button in the Cells group and select Row Height or Column Width.  Enter a value in the box and click the OK button.
 Merging Cells
1. Select the cells you want to merge.
2. Click on the Home tab.
3. Click the arrow on the Merge & Center button in the Alignment group and do one of the following:
a. To merge the cells and center the text, select Merge & Center from the resulting menu.
b. To merge without centering, select Merge Across or Merge Cells from the resulting menu.
NOTE:  To split merged cells, select cells, click arrow on Merge & Center button, select Unmerge Cells from resulting menu.
Changing the Workbook View
1. Click on the View tab.
2. In the Workbook Views group, do one of the following:
a. To view the workbook in Normal view, click the Normal View button (this is the default).
b. To view as it will look when printed, click the Page Layout View button.
c. To view and adjust page breaks, click the Page Break Preview button. 
d. To view the workbook in full screen view, click the Toggle Full Screen View button (press Esc key to return to default view.)
NOTE: to quickly change the workbook view, click the Normal, Page Layout, or Page Break Preview button on the Status bar.
Freezing a Row or Column
You can freeze horizontal or vertical panes to keep row and column labels or other data visible as you scroll through the worksheet.
1. Click on the View tab.
2. Do one of the following:
a. To freeze rows, select the row below where you want the split to appear.
b. To freeze columns, select the column to the right of where you want the split to appear.
c. To freeze both rows & columns, select the cell below and to the right of where you want the split to appear.
3. Click the Freeze Panes button in the Window group.
4. Select Freeze Panes from the resulting menu.
5. To unfreeze, click the Freeze Panes button in the Window group and select Unfreeze Panes from the resulting menu.
NOTE:  To freeze the top row or first column, click the Freeze Panes button in the Window group and select Freeze Top Row or Freeze First Column from the resulting menu.
Previewing and Printing a Workbook
1. Click on the File tab.
2. Select Print in the left pane (Print Preview is automatically displayed in the right pane).
3. Select print options in the middle pane.
4. Click the Print button (or Ctrl + P) to print the document.
[bookmark: _Toc342482714]Next Steps
After you have completed Step 1:
1. Submit your worksheet to your BLM State Office Planning and Environmental Coordinator (P&EC) for approval. (Columns 3, 4, & 5 should be filled in; column 13 should have some cross-references identified.)

2. After the state P&EC has approved your worksheet:
a. Schedule a facilitator for Step 2 (contact the NTC if you need help or have questions.)
b. Invite cooperating agencies and key partners to participate in Step 2 (this is optional, but highly recommended.)
c. Schedule a time and location for Step 2 so that all participants (interdisciplinary team, key partners and cooperating agencies, MANAGER, and facilitator) can attend the entire session.
d. Start watching Module 2 of the Plan Implementation Strategy training.

Good luck!!

[bookmark: _Toc342482715]Acronyms Used in Plan Implementation Training 

	ACEC
	Area of Critical Environmental Concern

	APD
	Application for Permit to Drill

	ARRA
	American Recovery and Reinvestment Act of 2009

	AWP
	Annual Work Plan

	BLM
	Bureau of Land Management

	BPS
	Budget Planning System

	DO
	District Office (BLM)

	DOI
	Department of the Interior

	ERMA
	Extended Resource Management Area

	FO
	Field Office (BLM)

	FRCC
	Fire Regime Condition Class

	FY
	Fiscal Year

	ID Team
	Interdisciplinary Team

	KRC
	Knowledge Resource Center

	LUP
	Land Use Plan

	NCA
	National Conservation Area

	NLCS
	National Landscape Conservation System

	NTC
	National Training Center

	OHV
	Off-Highway Vehicle

	P&EC
	Planning and Environmental Coordinator

	PE Code
	Project Element Code

	PTA
	Project Target Allocation

	R&PP
	Recreation & Public Purposes

	RMP
	Resource Management Plan

	ROD
	Record of Decision

	ROW
	Right of Way

	SO
	State Office (BLM)

	SRMA
	Special Recreation Management Area

	SRP
	Special Recreation Permit

	WO
	Washington Office (BLM)

	WSA
	Wilderness Study Area

	WUI
	Wildland Urban Interface






[bookmark: _Toc342482716]Example Excel Spreadsheet 

Click the first link to go to a filled out example Plan Implementation spreadsheet, which was developed from actual BLM plans.  You can use it for ideas if you get stuck. 

Link to EXAMPLE Excel Spreadsheet.


Click on the second link to get a copy of the blank Excel spreadsheet.   This is what you will use to start populating the columns for Step 1.  Be sure to save early and often!

Link to BLANK Excel Spreadsheet
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